TABLE OF CONTENTS

Introduction ..................................................................................................................3
  What is the Seametrics Turbo Sensor?........................................................................3
  Initial Inspection and Handling................................................................................3
  Do’s and Don’ts......................................................................................................3

Installation and Operation..........................................................................................4
  Connecting the Turbo to a Computer.................................................................4
  Installing the Aqua4Plus Software......................................................................4
  Installing the Sensor..............................................................................................5
  Collecting Data.......................................................................................................5

Maintenance ...............................................................................................................8

Trouble Shooting.........................................................................................................9
  Erratic Readings.....................................................................................................9
  Grounding Issues..................................................................................................9

Appendix A: Technical Specifications ......................................................................10

Appendix B: Field Calibration ....................................................................................11

Appendix C: Alternate Connection Options.............................................................13
  Connecting via RS232 Serial Port......................................................................13
  Connecting with a USB/Serial Adapter..............................................................13

Appendix D: Reading the Seametrics Turbo Sensor
  via Direct Read........................................................................................................15
  Reading Via Modbus® .........................................................................................15
  Setting Baud Rate.................................................................................................15
  Reading Via SDI-12..............................................................................................17

Reordering Information ............................................................................................18

Seametrics Limited Warranty....................................................................................21
What is the Turbo Sensor?

Seametrics’ Turbo Smart Sensor is an integrated datalogger and turbidity/temperature sensor. This sensor networks with all of the Seametrics This industry standard digital RS485 interface device records over 250,000 records of turbidity, temperature, and time data, operates with low power, and features easy-to-use software with powerful features.

The unit is programmed using Seametrics’ easy-to-use Aqua4Plus control software. Once programmed the unit will measure and collect data on a variety of time intervals.

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage. If any damage is apparent, note the signs of damage on the appropriate shipping form. After opening the carton, look for concealed damage, such as a cut cable. If concealed damage is found, immediately file a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.

Don’t support the device with the connector. Use a strain relief device to take the tension off the connectors.

Do store the device in a dry, inside area when not in use.

Don’t allow the device to free-fall down a well as impact damage can occur.

Do install a desiccant tube if using a gauge sensor.

Don’t bang or drop the device on hard objects.

Do install the device so that the connector end is kept dry.

Don’t touch or bump the sensor “eye” or wiper blade.

Do install so wiper blade is free to move.
Connecting the Turbo to a Computer

The Turbo cable is terminated with a weather-resistant connector. Connect the weather-resistant connector to your computer’s USB port as shown below. (For alternate connection options, see Appendix C.)

![Diagram of Turbo connection to computer](image)

*Connect the Turbo to your PC using a USB to RS485 adapter. (See Appendix C for alternate connection options.)*

Installing the Aqua4Plus Software

The Turbo sensor comes with the Aqua4Plus host software that is installed on your PC or laptop. Use this software to program the datalogger, to retrieve data from the logger, to view collected data, and to export data to external files for use with spreadsheets or databases.

Refer to the Aqua4Plus software manual for details on installing and using Aqua4Plus.

Using the Sensor Without Aqua4Plus

Most users will use the sensor with Seametrics’ Aqua4Plus software. However, this sensor is quite versatile, allowing you to do the following:

- Read via the Modbus® protocol using your own software.
- Read via SDI-12 protocol.
- Display readings on a panel meter.

If you want to use one of these methods, see Appendix D or contact Seametrics for further details.
Installing the Sensor

Lower the sensor to the desired depth. Fasten the cable to the well head using tie wraps or a weather proof strain-relief system. When securing a vented cable, make sure not to pinch the cable too tightly or the vent tube inside the cable jacket may be sealed off. Take a measurement to insure the sensor is not installed below its maximum range.

Be sure the supplied cap is securely placed on the weather-resistant connector at the top of the cable. Do not install such that the connector might become submerged with changing weather conditions. The connector can withstand incidental splashing but is not designed to be submerged.

Collecting Data

Following is a brief overview on using Aqua4Plus to collect data. Please refer to the Aqua4Plus Instruction Manual for further details on configuring and using Aqua4Plus.

Real Time Monitor

- Click Single to get a single reading.
- Click Start to get a reading once a second.
- The unit will power up, run the wiper once, and then start taking readings.
- Click Stop to stop the reading.

Note: These are snapshot readings and are not recorded on the sensor.

The Real Time Monitor gives a snapshot of the current readings on the sensor.
Setting up a Data Recording Session

Click the tool button. A Session Profile Window will open. Refer to the *Aqua4Plus Instruction Manual* for details in describing your session profile. Click the Start button to save the session to the sensor and begin recording. Before each reading, the sensor will apply power to the turbidity sensing unit and run the wiper once. If your polling interval is 10 seconds or less, the sensing unit will remain on and will only wipe once when the session is first started.

Using the Session Profile Window, describe the test steps for your particular test.
Retrieving Data from the Sensor/Datalogger

- Click on the session you want to upload.
- Click the tool button.
- Select a file location.
- Click Save.
- Click Start.

Viewing Data

- Click the tool button to view data as a table.
- Click the tool button to view data as a graph.
- Navigate to the desired file, then click the Open button. (If the File Open box does not appear, click the File Menu, then select Open.)

The File Display window displays your data in a tabular format.
Exporting Data to .csv or .xls Files

- Using the File Display window, open the file you want to export.
- Click on the tool button.
- Select a file location and enter a name for the file.
- Select a file type.
- Click Save.

The Graph Window displays your data on an XY coordinate graph.

A Word About Units

Temperature readings from the sensor can be displayed in various units, such as degrees Celsius or degrees Fahrenheit for temperature. Select the units you want from the Options | Units menu. Turbidity is always in NTU.

Maintenance

Sensor: There are no user-serviceable parts. If problems develop with sensor stability or accuracy, contact Seametrics. If the unit has been exposed to hazardous materials, do not return without notification and authorization.

Cable: Cable can be damaged by abrasion, sharp objects, twisting, crimping, crushing, or pulling. Take care during installation and

End Connections: The contact areas (pins & sockets) of the connectors will wear out with extensive use. If your application requires repeated connections other types of connectors can be provided. The connectors used by Seametrics are not submersible, but are designed to be splash-resistant.

Wiper Blades: The effectiveness of the wiper in maintaining a clean optical surface will eventually be compromised, the rate being dependent on the water under investigation and the number of wiping cycles carried out. We recommend periodic inspection of the wiper’s silicon pad to determine if the wiper material is deteriorating or if there is an excessive buildup of material from bio-fouling. In addition, as a precaution we recommend changing the wiper prior to each long term deployment. The wiper is a consumable item. Wiper packs are available from Seametrics to avoid cable damage. If a section of cable is damaged, it is recommended that you send your sensor back to replace the cable harness assembly.
Erratic Readings

Erratic readings can be caused by a poor connection, damaged cable, moisture in the unit, or a damaged transmitter. In most cases, erratic readings are due to moisture getting into the system. The first thing to check is the connection. Look for moisture between contacts or a loose or broken wire. Next, check the cable for cracking or fraying. If the connections and cable appear OK, but the readings are still erratic, the transmitter may be damaged. Contact Seametrics for evaluation and repair. Erratic and erroneous readings can also occur due to improper grounding. See Grounding Issues, below.

Grounding Issues

It is commonly known that when using electronic equipment, both personal and equipment need to be protected from high power spikes that may be caused by lightning, power line surges, or faulty equipment. Without a proper grounding system, a power spike will find the path of least resistance to earth ground—whether that path is through sensitive electronic equipment or the person operating the equipment. In order to ensure safety and prevent equipment damage, a grounding system must be used to provide a low resistance path to ground.

When using several pieces of interconnected equipment, each of which may have its own ground, problems with noise, signal interference, and erroneous readings may be noted. This is caused by a condition known as a Ground Loop. Because of natural resistance in the earth between the grounding points, current can flow between the points, creating an unexpected voltage difference and resulting erroneous readings.

The single most important step in minimizing a ground loop is to tie all equipment (sensors, dataloggers, external power sources and any other associated equipment) to a single common grounding point. Seametrics recommends connecting the shield to ground at the connector end.
General Specification

The Turbo sensor is a microprocessor based digital intelligent sensor designed to measure and record turbidity, temperature, and time.

Wiring

- For Modbus® with 5-pin connector:
  - White
  - Purple
  - Yellow
  - Brown
  - Blue
  - Shield
  - 12 VDC+ (Vaux)
  - Modbus D-
  - Modbus D+
  - SDI-12 (Not used)
  - Ground

- For SDI-12 with 5-pin connector:
  - White
  - Purple
  - Yellow
  - Brown
  - Blue
  - Shield
  - 12 VDC+ (Vaux)
  - Modbus D- (Not used)
  - Modbus D+ (Not used)
  - SDI-12 Signal
  - 12 VDC – (Gnd)

- For SDI-12 without connector:
  - White
  - Purple
  - Yellow
  - Brown
  - Blue
  - Shield (may be green)
  - 12 VDC+ (Vaux)
  - Modbus D- (Not used)
  - Modbus D+ (Not used)
  - SDI-12 Signal
  - 12 VDC – (Gnd)
  - Earth ground

Cable

- OD 0.28” maximum
- Break Strength 138 lbs.
- Maximum Length 2000 feet
- Weight 4 lbs. per 100 feet

Input Power

12 Vdc nominal (6–16 Vdc)

Ranges

- 0 - 400 NTU
- 0 - 3000 NTU
Calibration can only be done when there are no sessions stored on the sensor. If there are any sessions stored on the sensor, upload any data you want and then erase the session before continuing.

**One-Point Calibration:**

-- Computing Calibration Value --

- Place sensor in sample to be measured. Allow time for sensor to stabilize.
- If sample is of known specific value, enter this value in the Ref box for the first point.
- Alternately, using an accurate alternate measuring device, take a measurement. Enter this value in the Ref box for the first point.
- Click first Measure button.
- When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

-- Applying Calibration Value --

- Click the Apply button to apply calibration value.
- The computed b value will be transferred to the calibration field.
- Click OK to save the value to the sensor.

**Two-Point Calibration:**

-- First Calibration Point --

- Place sensor in sample to be measured. Allow time for sensor to stabilize.
- If sample is of known specific value, enter this value in the Ref box for the first point.
- Alternately, using an accurate alternate measuring device, take a measurement. Enter this value in the Ref box for the first point.
- Click first Measure button.
- When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

-- Second Calibration Point --

- Place sensor in sample with a different value. Allow time for sensor to stabilize.
- If sample is of known specific value, enter this value in the Ref box for the second point.
- Alternately, using an accurate alternate measuring device, take a measurement. Enter this value in the Ref box for the second point.
• Click second Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the pop-up box.

-- Applying Calibration Values --
• Click the Apply button to apply calibration values.
• The computed m and b values will be transferred to the calibration fields.
• Click OK to save the values to the sensor.

Appendix C: Alternate Connection Options

Connecting via RS232 Serial Port
The Turbo cable is terminated with a weather-resistant connector. Connect the weather-resistant connector to your computer’s serial port as shown below.

Connect the Turbo to your computer using an RS485/RS232 adapter and an interface cable.

Connecting with a USB/Serial Adapter
USB-to-Serial cables are readily available from many electronics and computer stores, as well as numerous sites on the Internet. Seametrics has tested and recommends the Keyspan USA-19HS. It is available from Seametrics as well as from many sites on the Internet. Install as follows:
• Plug into USB port.
• Install the drivers provided with the particular unit.
• Determine the port number to which the adapter is assigned.
  • Right-click on My Computer.
From the popup menu, select Manage to open the Computer Management window.

On left panel, click on Device Manager.

On right panel, double-click on Ports.

A list of active COM ports will be displayed. Note the COM number assigned to the adapter you just installed.

For example: 🔄 Keyspan USB Serial Port (COM4)

Close Manager.

• Connect to the sensor.

• On the Aqua4Plus software, select the COM port noted above. (If you do not see your new COM port in the dropdown box, open the Communications dialog box from the Options menu. Increase the Highest COM port number, up to a maximum of 15.)

Connect the Turbo to your computer using a USB to Serial adapter and an interface cable.
Reading the AquiStar® Turbo Sensor via Direct Read

While the Turbo comes with Seametrics’ easy to use Aqua4Plus software, you can also use standard Modbus® RTU or SDI-12 equipment to easily take readings, so as to tie into your existing equipment or networks.

You may need to use Aqua4Plus to set the baud rate. (You do not need to set the baud rate for SDI-12). For Modbus you must have Turbo firmware version 2.0 or higher. For SDI-12 you must have version 2.2 or higher.

Reading Via Modbus®

Setting Baud Rate

our sensor comes configured to communicate at 38,400 baud, with 8 data bits, one stop bit, and no parity. The sensor can also be set to 19,200 or 9600 baud, if needed for your application.

If needed, set your sensor to the desired baud rate as follows:

- Click on the Configure menu, and then select Advanced.
- From the flyout menu, select Sensor Baud Rate. (You may be asked for a password. Enter admin.)
- On the popup box, click the down-arrow and select the baud rate you need, and then click OK.

Once you have changed the baud rate on the sensor, you will not be able to talk to it with Aqua4Plus until you change the baud rate for Aqua4Plus, as follows:

- Click the Options menu, and then select Baud Rate.
- On the popup box, click the down-arrow, select the baud rate you need, and then click OK.

The current Aqua4Plus baud rate is displayed in the lower right corner of the main Aqua4Plus window.

Taking Measurements

Read measurements using Modbus function 03 – Read Holding Registers.

Readings are located in two registers each, starting at address 62592. (AquiStar® register addressing is zero based, i.e., starts at zero. If your equipment uses one based addressing, you will need to add one to the register addresses.)

<table>
<thead>
<tr>
<th>Register addresses for AquiStar Turbo Sensor</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zero Based</strong></td>
</tr>
<tr>
<td>Temperature</td>
</tr>
<tr>
<td>Turbidity</td>
</tr>
</tbody>
</table>
Power On Function
In order to save power, the power to the sensing probe on the Turbo is normally off, even when the Turbo sensor itself is powered. The sensing probe requires a warm-up or stabilization time before returning valid readings. The sensing probe is turned on when a reading is requested or when a Power On command is written to the Turbo.

(Note: If you are recording sessions, reading with Aqua4Plus, or using SDI-12, you do not need to be concerned with the stabilization period. It is automatically taken care of in these situations. You only need to be concerned when using your own device to take Modbus readings.)

There is a “power on” register on the Turbo (register 62720 or 0xF500). When a positive value “n” is written to this register, the power is turned on to the sensing probe and remains on for n/4 seconds. When a reading is requested, the timer is reset and the sensing element remains on for another n/4 seconds. To force the power off immediately after a reading, for power savings, write a zero to the register. If the power to the entire Turbo sensor is turned off, this value defaults to 48 (or 12 seconds).

The recommended procedure to ensure proper warm-up/stabilization and to conserve power is:

- Write Power On value of 48 (48/4 = 12 seconds)
- Power turns on
- Starts sampling about two times per second
- Wait 10 seconds then request a reading
- Returns most recent sample
- Resets Power On value to 48 (48/4 = 12 seconds)
- Write Power On value of 0 (zero)
- Turns power off
- Retains last reading

If you Cannot Write to the Power On Register
If you are reading your device using a meter or other device that cannot write the Power On but simply takes readings on a specified schedule, be sure to set the polling interval to less than 12 seconds. This will ensure that the sensing probe is always powered up and readings should be fresh and stable. Note that the first reading when you turn on the sensor and meter will be old but will refresh within a second or two.

For further information and detailed Modbus examples, refer to our website at www.seametrics.com.

Data Format
The data is returned as 32-bit IEEE floating-point values, high word first, also referred to as big-endian or float inverse.

Wiper
Before each reading, the sensor will apply power to the turbidity sensing unit and run the wiper once. If your polling interval is 10 seconds or less, the sensing unit will remain on and will only wipe once when first started.
Reading Via SDI-12

**Addressing**
Default SDI-12 Address: 0

**SDI-12 Command Nomenclature**
- `<a>` = Sensor address
- `{crc}` = SDI-12 compatible 3-character CRC
- `<cr>` = ASCII carriage return character
- `<lf>` = ASCII line feed character

*highlighted values* indicate variable data

**SDI-12 Commands**

//*** Sensor Identification
`<a>! <a>13 INWUSA ATurb2.2ssssssssss<cr><lf>`
// note: 2.2 will change to reflect current
// firmware revision
// sssssssss = device serial #

//*** Acknowledge Active, Address Query
`<a>! <a><cr><lf>`
`?! <a><cr><lf>`

//*** Change Address
`<a>A<b>! <b><cr><lf>`
// change address from `<a>` to `<b>`

//*** Request measurement
`<a>M! <a>0022<cr><lf>`
// request all measurements
`<a>D0! <a>+24.2412+458.73<cr><lf>`
// read: temperature and turbidity

`<a>M1! <a>0021<cr><lf>`
// request measurements
`<a>D0! <a>+24.2412<cr><lf>`
// read: temperature

`<a>M2! <a>0021<cr><lf>`
// request measurements
`<a>D0! <a>+458.73<cr><lf>`
// read: turbidity

//*** Request measurement with CRC
`<a>MC! <a>0022<cr><lf>`
// request all measurements w/CRC
`<a>D0! <a>+24.2412+458.73{crc}<cr><lf>`
// read: temperature and turbidity

`<a>MC1! <a>0021<cr><lf>`
// request measurements w/CRC
`<a>D0! <a>+24.2412{crc}<cr><lf>`
// read: temperature

`<a>MC2! <a>0021<cr><lf>`
// request measurements w/CRC
`<a>D0! <a>+458.73<cr><lf>`
// read: turbidity
//*** Concurrent measurement
<a>C! <a>0022<cr><lf>  // request all measurements
<a>D0! <a>+24.2412+458.73<cr><lf>  // read: temperature and turbidity

<a>C1! <a>0021<cr><lf>  // request measurements
<a>D0! <a>+24.2412<cr><lf>  // read: temperature

<a>C2! <a>0021<cr><lf>  // request measurements
<a>D0! <a>+458.73<cr><lf>  // read: turbidity

//*** Concurrent measurement with CRC
<a>CC! <a>0022<cr><lf>  // request all measurements w/CRC
<a>D0! <a>+24.2412+458.73{crc}<cr><lf>  // read: temperature and turbidity

<a>CC1! <a>0021<cr><lf>  // request measurements w/CRC
<a>D0! <a>+24.2412{crc}<cr><lf>  // read: temperature

<a>CC2! <a>0021<cr><lf>  // request measurements w/CRC
<a>D0! <a>+458.73<cr><lf>  // read: turbidity

For further information and SDI-12 examples, see our website at www.seametrics.com.
Seametrics' limited warranty:

Seametrics warrants that products manufactured by Seametrics, when delivered to you in new condition in their original containers and properly installed, shall be free from defects in material and workmanship. **Seametrics products are warranted against defects for a period of two (2) years from date of installation, with proof of install date. If no proof of install date can be provided, warranty period will be two (2) years from date of shipment from Seametrics, as defined on Seametrics’ invoice.** Seametrics' obligation under this warranty shall be limited to replacing or repairing the part or parts, or, at Seametrics’ option, the products, which prove defective in material or workmanship. The following are the terms of Seametrics’ limited warranty:

a. Buyer must give Seametrics prompt notice of any defect or failure and satisfactory proof thereof.

b. Any defective part or parts must be returned to Seametrics’ factory or to an authorized service center for inspection.

c. Buyer will prepay all freight charges to return any products to Seametrics’ factory, or another repair facility, as designated by Seametrics.

d. Defective products, or parts thereof, which are returned to Seametrics and proved to be defective upon inspection, will be repaired to factory specifications.

e. Seametrics will deliver repaired products or replacements for defective products to the buyer (ground freight prepaid) to the destination provided in the original order.

f. Products returned to Seametrics for which Seametrics provides replacement under this warranty shall become the property of Seametrics.

g. This limited warranty covers all defects encountered in normal use of Seametrics products, and does not apply to the following cases:

   i. Loss of or damage to Seametrics product due to abuse, mishandling, or improper packaging by buyer

   ii. Failure to follow operating, maintenance, or environmental instructions prescribed in Seametrics’ instruction manual

   iii. Products not used for their intended purpose

   iv. Alterations to the product, purposeful or accidental

   v. Electrical current fluctuations

   vi. Corrosion due to aggressive materials not approved for your specific product

   vii. Mishandling, or misapplication of Seametrics products

   viii. Products or parts that are typically consumed during normal operation

   ix. Use of parts or supplies (other than those sold by Seametrics) which cause damage to the products, or cause abnormally frequent service calls or service problems

h. A new warranty period shall not be established for repaired or replaced material, products, or supplied. Such items shall remain under warranty only for the remainder of the warranty period on the original materials, products, or supplies.

i. In the event that equipment is altered or repaired by the buyer without prior written approval by Seametrics, all warranties are void. Damage caused by equipment or accessories not manufactured by Seametrics may void the product’s warranty.

j. SOFTWARE: The Seller grants the user a non-exclusive license to use Seametrics’ software, according to the following limitations and conditions:

   i. The user may install the software on one or more desktop or laptop computers.

   ii. All title and intellectual rights to the software are owned by Seametrics.

   iii. No copies may be made or distributed except as described above.

   iv. The user may not modify or reverse-engineer the software.

THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY. NO IMPLIED WARRANTY, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, APPLIED TO THE PRODUCTS AFTER THE APPLICABLE PERIOD OF THE EXPRESS LIMITED WARRANTY STATED ABOVE, AND NO OTHER EXPRESS WARRANTY OR GUARANTY, EXCEPT AS MENTIONED ABOVE, GIVEN BY ANY PERSON OR ENTITY WITH RESPECT TO THE PRODUCTS, SHALL BIND SEAMETRICS. SEAMETRICS SHALL NOT BE LIABLE FOR LOSS OF REVENUES, OR PROFITS, OR INCONVENIENCES, EXPENSE FOR SUBSTITUTE EQUIPMENT OR SERVICE, STORAGE CHARGES, LOSS OF DATA, OR ANY OTHER SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGE CAUSED BY THE USE OR MISUSE OF, OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF SEAMETRICS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL RECOVERY OF ANY KIND AGAINST SEAMETRICS BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT SOLD BY SEAMETRICS AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK OF LIABILITY FOR LOSS, DAMAGE, OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE OR MISUSE OF, OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF SEAMETRICS.

SOME STATES DO NOT ALLOW LIMITATIONS ON THE DURATION OF AN IMPLIED WARRANTY, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. SIMILARLY, SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF CONSEQUENTIAL DAMAGE, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS; HOWEVER, YOU MAY ALSO HAVE OTHER RIGHTS WHICH MAY VARY FROM STATE TO STATE.